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This document contains intellectual property (IP) of Involute Simulation Softwares Inc. It 

is protected by Copyrights of Involute Simulation Softwares Inc.

It is intended for the sole use of training HyGEARS customers, by persons agreed by 

Involute Simulation Softwares Inc.

Any infringement to this will be followed up legally.

Thank you for the respect of the IP and work involved in preparing this.
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HyGEARS, THE GEAR PROCESSOR, was developed to help Spiral-Bevel and Hypoid 

gear designers and manufacturers reduce production time while increasing the quality of 

their products. 

HyGEARS may also be used for the analysis of internal and external Spur and Helical 

gears, Straight bevel gears, Coniflex bevel gears, Hirth couplings, and Face gears.

HyGEARS is built around an advanced Graphic User Interface, which simplifies the 

operations and the understanding of the results. 

All results are given in WYSIWYG mode which means that, in HyGEARS, what you see 

is what you get.

Measured Contact Pattern HyGEARS’ Simulation
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• General presentation of HyGEARS

• Vector simulation of gear manufacturing processes

• Tooth Contact Analysis (TCA)

• Ease Off Surface

• TCA, Transmission Error and the Contact Pattern

• Numerical Contact Pattern development

• Cutting processes and machines

• Software calibration

• HyGEARS Graphic User Interface (GUI): 

• Starting HyGEARS

• Parent Window 

• Display Modes

• Child Windows

• Graphic controls

• Context sensitive Help

• Geometry Summary editor

• V-H Settings

• Creating a New Geometry;  Spiral bevel / hypoid, Coniflex Spur. Helical, Face gear,  Beveloid, Straight bevel

• Production Control: Corrective Machine Settings (Closed Loop) / Reverse Engineering

• 5Axis CnC Manufacturing

• Graphic Display Functions

• Teeth and Machines: geometry, 5 Axis CNC manufacturing

• Kinematics: TCA, LTCA

• Measurement: target file, analysis, Corrective machine settings, Reverse engineering

• 2D Graphs:

• FEA meshing; Finite Strips meshing

• Addendums
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Main HyGEARS features …

• 3D displays throughout;

• Internal architecture flexibility allows expansions;

• Many different ways to arrive at a given goal;

• Fast and easy to use.

Some HyGEARS limitations …

• Design of face-milled hypoid gears limited to 90° shaft angle;

• Design of face-milled spiral-bevel gears limited to ~ 25-140° shaft angle;

• Design of face-hobbed hypoid and spiral-bevel gears not allowed at this 

time (import of existing summaries allowed);
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1994-2004

Japan:

Yutaka Seimitsu Kogyo

Mitsubishi Motors

Toyota Motor Corp.

Subaru Motors Corp.

Subaru Central Labs (Tokyo)

Hino Trucks

Honda Motors

Showa Gears

Daihatsu

Korea:

KIA Motors

KIA Heavy Industries

Europe:

Romax Technology (UK)

USA:

DANA Corp.

American Axle and Manufacturing

GM

Linamar
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From 2013 -

China:

SEW Eurodrive (Tianjin) 

miniGears (Suzhou)

Harbin Marine Boiler TRI

Europe:

Drive System Design (UK)

Reliance Precision Ltd (UK)

Spirotec (France)

Robert Bosch GmbH (Germany)

Neugart GmbH (Germany)

PTR-TEC (Germany)

BMW (Germany)

EWS Weigele GmbH (Germany

DEPRAG (Germany)

FZG (Germany)

ZG Hypoid (Germany)

Hoer Innovativ (Germany)

MAN Trucks & Bus (Germany)

Haas-Multigrind (Germany)

ZG Hypoid (Germany)

Eppinger Gears (Germany)

EWS Weigele               (Germany)

Sandvik GmbH (Austria)

GB Ricambi (Italy)

Breton Spa (Italy)

GB Gearboxes (Italy)

MdM Mecatronics (Italy)

Tecnogear (Italy)

Kumera Drives (Finland)

GKN Driveline (Sweden)

USA:

EMCO Gears

Dynamic Engineering

Rexnord Geared Products

GMT Gears

DTD Precision

Perry Technology Corp

Afton Chemical

India:

Bevel Gears India

Shivam Autotech

Eppinger Tools

Bharat Forge Limited

Israel:

Precision Products

Japan:

Takeda Trade Co.

Canada:

Usimax Inc
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Machines are easily added if the 

requested one is not already in the 

list.

Besides, an existing machine may 

be modified to suit a specific user’s 

needs and then a machine variant is 

created with a different name.

The supported controllers are:

• Fanuc

• Okuma

• Siemens

• Heindehein

• Mazak



1983-1985: Master’s Thesis – Development of  a 3D CAD package to    

analyze spiral-bevel gears

1985-1987: PhD Thesis – Optimization of the kinematics of  spiral-

bevel gears

1989: DEC VAX-Station Version

1991: 1st Windows 3.1 Version (VB3 + Fortran)

1992: LTCA – Loaded Tooth Contact Analysis

1993: 1st Meeting with Yutaka Seimitsu, Japan; Calibration on 

Yutaka and Gleason machines
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1994: 1st order Corrective machine settings; JIMTOF

1995: HyGEARS V 1.0 Single precision

1996: Reverse Engineering

1997: 2nd and 2nd+ order Corrective Machine Settings

1999: HyGEARS V 2.0 Single+double precision

2000: Contact Elements, Grid output, Spur/Helical, …

2003: Face Hobbing Simulation

2006: Lapping Simulation and Prediction

2007: HyGEARS V 2.5

2010: Net-shape Straight Bevel Gears

2011: HyGEARS V 3.0 Coniflex

Universal 5 Axis CnC Interface

2012: HyGEARS V 4.0 Double precision

VS 2010 + .NET 4.0

~390,000  lines of code

2021: HyGEARS V 5.0 64 Bits; GPU 3D graphics

VS 2019 + .NET 4.7
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1: The reference machine is

discretized in a series of ref. frames

3: A Digital machine is 

created from the Vector Model

4: A Digital gear set is created 

with the Digital machine.

In Vector Simulation, a theoretical gear generator is simulated 

by translations and rotations applied to reference frames that 

determine the relations between cutting tool and machine.
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2: The Vector Model uses the ref.

frames of the discretized machine



Point on tooth flank:

Normal vector on tooth flank:

X = 𝑫 𝜏 3 𝑘 1 𝑅𝑎𝑑𝑖𝑎𝑙 𝐿1
3 𝐷𝑖𝑠𝑡 𝛾𝑚

2 𝜃3
3

𝑵𝒙 = 𝑵 𝜏 3 𝑘 1 𝐿1
3 𝛾𝑚

2 𝜃3
3

The coordinates and normal vectors at any point on the tooth 

flanks are obtained by applying machine specific rotations 

and translations to the cutter definition.
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Higher order cutting changes:

• Modified Roll

where: L1m: modified cradle angle

α3: work piece roll angle

Rr: ratio of roll, cradle to work piece

Cr: cradle ref. position

2C: 2nd Order parameter (Gleason notation)

6D: 3rd Order parameter (Gleason notation)

24E: 4th Order parameter (Gleason notation)

120F: 5th Order parameter (Gleason notation)

720G: 6th Order parameter (Gleason notation)

Higher order changes can be superimposed to the tool and work piece movements 

in order to achieve specific kinematic behavior.
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Higher order cutting changes:

• Helical Motion

where: Xbm: modified sliding base

α3: work piece roll angle

Rr: ratio of roll, cradle to work piece

Cr: cradle ref. position

1st : 1st Order parameter

2nd : 2nd Order parameter 

3rd : 3rd Order parameter

4th : 4th Order parameter

5th : 5th Order parameter

6th : 6th Order parameter
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Face Milling (single indexing)

Simulation of Face Milling and Face Hobbing processes supported for Spiral Bevel gears.

Face Hobbing (continuous indexing)
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The basis of all kinematics in HyGEARS is the Tooth Contact Analysis, or TCA, whereby the 

location of the Path of Contact is calculated, red line - left figure below, which leads to the 

Contact Pattern, blue patch - right figure below.

The location and dimensions of the Contact Pattern can be viewed in several ways, and may be 

optimized according to the user’s wishes using the Contact Pattern Development functions. 

(“CPat” function button)
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The Ease Off Surface represents tooth to tooth separation as meshing proceeds.

It can be seen as a measure of the discrepancy in conjugacy between 2 meshing surfaces.

1) Spur gear pair – basic 2) + crowning 3) + profile modification
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1. The Ease Off  is displayed in ref. to the Pinion tooth:

The displayed elements are:

– Contact Separation Axis

– Face Width Axis

– Radial Axis

– Ease Off surface, or discrepancy in conjugacy

– Path of Contact (PoC – red line)

– Contact Pattern (Blue patch)

– Edge values (0.11, 0.07, etc.)
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2. The pinion and gear tooth surfaces are digitized, i.e. the implicit surface equations are 

solved; therefore, on each tooth several points are known by:

– Surface parameters αc, S, α3

• αc: cutter blade angular position

• S:   position of a cutter blade to work contact point

• α3: work piece roll angle

– Coordinates X, Y, Z

– Normal vector Nx, Ny, Nz
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3. Contact points are calculated at each tooth flank coordinate; 

– A contact point is obtained when:

• The pinion and gear Coordinates are equal in a common ref. frame;

• The pinion and gear Normal are equal and opposed in a common ref. frame;

– The following are obtained at each contact point, 

• coordinates, 

• normal components, 

• tooth surface parameters (αc, S, α3) and 

• tooth rotation (θ3, ϕ3);
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– An image of the Ease Off or tooth to tooth meshing separation is obtained by scanning the 

pinion and gear teeth for contact points;

– Using 1 ref. point, tooth separation is calculated as function of the T.E. multiplied by the 

contact radius on the gear at each contact point;

– T.E. is defined as : 

where: δϕ3: T.E.

ϕ3: angular position of the Gear

θ3: angular position of the Pinion

mg: gear ratio
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δφ3 is the gear angular position error, 

or Transmission Error (TE) value

φ3 is the gear calculated angular

position error

θ3 mg is the gear theoretical angular

position, equal to the product of

the pinion angular position times

the speed ratio.
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Spiral-bevel gears

Spur / Helical gears
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Path of Contact

Profile Contact
Edge Contact

(pinion tip)

Edge Contact

(gear tip)

Path of Contact

Profile Contact

Contact Lines

Straight bevel gears

Path of Contact

Contact Lines

Contact Lines



Tip Edge Contact: to be avoided
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Contact Area

Edge



Tip Edge Contact: to be avoided
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Start of Contact End of Contact

Start of Contact
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Start of Contact End of Contact

Start of Contact
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Start of Contact End of Contact

Start of Contact
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Truncated

Contact Areas

Complete 

Contact Areas

Truncated

Contact Areas



Hypoid gear Worm gear

Face gear
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Tooth Pair Measured  Simulated  1 

(R.E.) 

Simulated  2 

(R.E. + ErrS) 

Simulated  3 

(R.E. + ErrS + Diff.) 

 
P01-G01 

    
 

P01-G19 
    

 
P01-G33 

    
 

P04-G01 

    
 

P04-G19 
    

 
P04-G33 
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In TCA and LTCA, HyGEARS can account for positional errors in three directions: pinion 

Offset “E”, pinion MD “P” and gear MD “G”.  Additionally, pinion and gear Radial may be 

used directly. 

This feature is available for all HyGEARS supported gear types. 

Alignment, shaft angle error,  and gear eccentricity can also be introduced to predict the 

behavior under load or in an actual gearbox.

The effects on TE, Contact Pattern and Load Sharing, may be investigated using the convenient 

V-H Settings Editor .

P

E

Radial

Radial
G

Shaft 

Angle

Alignment

Gear 

Run out

Pinion 

Run out
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To develop a Contact Pattern, HyGEARS offers 

sophisticated functions where the location and bias 

of the Contact Pattern can be specified.

The amplitude of the TE curve can also be 

modified to accommodate specific operating 

conditions.

Contact Pattern Development can be done on 

• Fixed Setting spiral-bevel gears, 

• Modified Roll spiral-bevel gears, 

• Duplex Helical spiral-bevel gears,

• SimplexT spiral-bevel gears,

• Cyclo-Palloid spiral-bevel gears,

• Face Hobbed spiral-bevel gears,

• Straight bevel gears,

• Coniflex bevel gears

© Involute Simulation Softwares Inc. 2021



Contact Pattern development is done in several steps:

– The Ease Off  surface is modified through changes in Pinion machine settings;

– The Gear member is either conjugate to the Generating Gear, for a generated gear set, or is the 

Generating Gear  for a non generated gear set; changes to the Ease Off come from the Pinion;

– In practice, the R.E. algorithm is applied using deviations in ref. to the current pinion surface, which 

are reflected in the Ease Off;

– CP is centered where requested by the user;

– Bias is modified until user request is reached;

– Bias is calculated between the 1st and last points of the PoC along the profile;

– No undercutting check;

– Tooth depth is maintained at mid-face width;
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Mean Point
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3 ->
 

Mean Point

 

Mean Point
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3 ->  

Mean Point

 

Mean Point

3 [“]

3 ->  

Helixform Gear Set
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Mean Point

 

Mean Point

3 [“]

3 ->  

Mean Point

 

Mean Point

3 [“]

3 ->  

Mean Point

 

Mean Point

3 [“]

3 ->  

Modified Roll Gear Set
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Straight Bevel Gear Set
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Change in CP bias and TE shape/amplitude

High CP/TE=20 arc-sec Mid CP/TE=0 arc-sec Low CP/TE=20 arc-sec
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HyGEARS supports most popular cutting 

processes, such as :

• Fixed Setting ® 

• Modified Roll ® 

• Duplex Helical ® 

• Spread Blade ® 

• Semi-Completing

• Formate ®

• Helixform ® 

• Face Hobbing 

• Cyclo-Palloid

® The Gleason Works, Rochester, N.Y.

+ SimplexT 

(Involute Inc.)
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Duplex Helical: Tilted spread blade pinion cutter

Tilted spread blade gear cutter

Helical motion

Different pinion and gear cutters
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SimplexT: Tilted spread blade pinion cutter

Non-tilted spread blade gear cutter

No helical motion

Identical pinion and gear cutters
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HyGEARS supports most popular cutting machines:

Gleason: 7A

16

26

102, 106, 108

116, 118, 122

606, 607

613, 631, 641

645, 650, 655, 675

Phoenix (i.e. 175)

Basic (YH 603)

A Machine Converter, included in the Geometry 

Summary Editor, allows machine conversion.

Klingelnberg: Neutral

5Axis CNC machines:

“AC”, “BC”, “BA” Types
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For Spur and Helical gears, HyGEARS supports 

Rack and Shaping tools and movements.

Profile modifications may be introduced, up to 

the 4th order, as well as crowning.

Modules down to 0.1 [mm] and as large as 30 

[mm] are easily accommodated by HyGEARS.
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Straight Bevel gears are traditionally cut on a 2-tool generator. In HyGEARS, with or without 

lengthwise crowning, these are referred to as Straight Bevel gears to distinguish with Coniflex. 

HyGEARS supports:

• Tooth shape for gear box differentials: 2-tool generator type machine; straight edge blade; + 

M.Roll; often aimed to forging.

• Standard tooth shape: 2-tool generator type machine; straight edge blade; M.Roll can be 

used on CnC machines.

• Both variants can be cut on CnC machines using; CoSIMT, Ball-Mill and End-Mill tools.
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In HyGEARS, Coniflex® refers to the cutting process using a dish-type face mill cutter.

Gleason machines 102, 104, 114 and 134 are supported in native mode. Coniflex® gears can 

also be cut on 5Axis CnC machines where each side of a tooth is generated using the same 

cutter on opposite sides of the work piece.
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Gleason Coniflex Generator 5Axis CnC Machine



Fixed Setting Hypoid Pinion Duplex Helical Hypoid Pinion

Face Hobbed Gear Set
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Straight Bevel Gears Worm Gears
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Face Gears
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Splines/Internal Gears Helical Gears
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Beveloid Gears Worm & Helical Gears
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Spurniflex Gears Spurved Gears
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Spiral Face Clutch Hirth Coupling
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Coniflex Bevel Gears Cogged Teeth Coupling
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Curvic Coupling
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HyGEARS was calibrated against Gleason’s and KIMoS

TCA (CP and TE), CMM control, Corrective Machine 

Settings, LTCA Contact Stresses, etc.

1993: Machine Calibration  (Gleason and Yutaka machines)

1994: Corrective M/C (Closed Loop vs Gleason’s GAGE)

1996: Experimental TE 

1997: Experimental LTCA 

1998: Fillet Stress (against FEA)

2001: Contact Stress (against Gleason’s LTCA)

2004: Bending and Contact Stress – Face Hobbing –

(against Gleason’s LTCA)

2006: Lapping Prediction (with AAM)

Consistently equivalent results are obtained.
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13x24 Face Milled Spiral Bevel gear set

Drive Side Coast Side

Gleason

HyGEARS
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8x39 Face Milled Spiral Bevel gear set

HyGEARS vs. Gleason Nominal

HyGEARS vs. KIMOS Nominal
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8x39 Face Milled Hypoid gear set

HyGEARS vs. Gleason - Pinion

HyGEARS vs. Gleason - Gear
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8x39 Face Hobbed Hypoid gear set

HyGEARS vs. Gleason - Pinion

HyGEARS vs. Gleason - Gear
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12x41 Face Hobbed Hypoid gear set

Gear Convex Gear Concave

Gleason

HyGEARS
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HyGEARS can display results in 1 of 2 modes:

• User Defined: user decides what Child window is to be displayed, and where;

• Pre-defined: 9 displays allow the user to access the most current functions

• TCA

• LTCA

• Geometry

• Loads (Radial, Axial, Transverse)

• Stock (Spiral bevel gears; Distribution)

• Modifications (Spur/Helical gears; Profile, Crowning)

• CMM (Target file)

• Corr-RE (Closed Loop; Reverse Engineering)

• Machine (5Axis CnC)
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- Tooth,

- Blank Contour,

- Diameter over Balls,

- Caliper Measurement,

- Full Model,

- Cutting Machine,

- Path of Contact,

- Contact Pattern,

- Ease Off, 

- FEA Model,

- Finite Strips, 

- Measured Surfaces,

- CMM Nominal Data

.
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- Tooth Errors (thickness and pitch),

- Comparison of Measured and

Simulated Surfaces,

- Corrective Machine Settings,

- Reverse Engineering,

- Cutter Blade,

- 2D Graphs 
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Dbl-Click maximizes / normalizes the current Child Window

^C copies the content of the current Child Window to the Windows Clipboard,

Shift^C copies the content of the current Child Window + Borders to the Windows Clipboard,

^E toggles the current Child Window in and out of the Auto Erase mode,

^F toggles the current tooth flank from Concave to Convex for spiral-bevel and hypoid 

gears, or from Left to Right for straight-bevel, spur and helical gears,

^H cycles through the various possible Hide levels (no, partial, total and rendering) for 

the current Child Window,

^I Zooms in one level (max = 10 levels)

^J cycles through the various possible display projections for the current Child Window,

^M cycles through the various possible Marker levels for the current Child Window,

^N toggles the current Child window to use either the coincidence of  tooth flank normals

(NoSep) or the tooth to tooth separation (Sep) to establish a contact point along the

PoC; it is enabled only on those PoC related Child windows such as the PoC, Bearing 

Pattern and 2D Graphs,

^O to open a geometry data file,

^P sends the content of the current Child Window to the Printer,

^R toggles on and off the display of the Reference Frames,

^S saves the current geometry data file,

^T causes the current display to recalculate and send the calculation trace to a Text

Results window (Ease Off Child window)

^U Zooms out one level

^Z toggles the current Child Window in and out of the AutoZoom mode.
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HyGEARS offers a Geometry Summary Editor, in which all aspects of the geometry, including 

Machine Settings, can be consulted and modified at any time.

“Pin”  -> Pinion Summary Editor

“Gea” -> Gear Summary Editor

Blank Data … Spiral / Zerol / Hypoid

• Checked: the entered 

OD is imposed

• Unchecked: FApxXp is 

modified to suit OD
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• Tapered Toe OD 

definition



Blank Data … Straight Bevel

© Involute Simulation Softwares Inc. 2021

• Checked: the entered 

OD is imposed

• Unchecked: FApxXp is 

modified to suit OD

Tapered Toe OD definition



Blank Data … Spur / Helical / Beveloid
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Spiral Bevel Cutter Data …

Fixed Setting
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Spread Blade / DH
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Spiral Bevel Cutter Data …



Face Hobbing
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Spiral Bevel Cutter Data …



Spiral Bevel TopRem Data …

• Linear Blade:  Linear and Circular TopRem

• Circular Blade:   Circular TopRem only
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Spiral Bevel Machine Data …

Changes with the process and machine:

• Fixed Setting

• Modified Roll

• Duplex Helical

• SimplexT

• Non Generated (Formate)

• Face Hobbing

• Cyclo-Palloid

• Etc.
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Higher Order Data … Controls Modified Roll and Helical Motion up to 6th order
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Other Data …

Spiral-Bevel / Hypoid Spur / Helical / Beveloid Straight-Bevel
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Operating Data …

AGMA: traditional way, 

AGMA-Mod: variant of AGMA

Aida+Terauchi: Spur gears

[ISO 46 ~ 320] – Prof. H. Winter
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Operating Data …

HPSTC: Highest point of single tooth contact (or Transfer Point); 

thus the PoC is first calculated;

Mid-height: mid tooth-height, at mid-face width;

Free: at tooth tip if AGMA Class < 9; 

at HPSTC  if AGMA Class > 8
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*** HYGEARS OIL DEFINITION FILE ***

;  

;  Source:

;  Errichello R.,  The Lubrication of Gears, Part I,  Gear Technology, March/April 1991

;  Errichello R.,  The Lubrication of Gears, Part II, Gear Technology, May/June 1991

;

;  Equivalences:

;  ISO        AGMA       SAE Crankase SAE Gear

;  --------------------------------------------------

;  1500                                     250

;  1000       8A                            250 (lower)

;   680       8                             140 (upper)

;   460       7                             140 

;   320       6                             140 (lower)

;   220       5           50                 90-85W

;   150       4           40                    85W

;   100       3           30                    80W

;    68       2       20W-30                    80W

;    46       1       20W-20                    75W

;

;  This is a comment line that is ignored

;  by HyGEARS. Comment lines should appear at the

;  beginning of the file, and start with a ";" semi-colon character.

;

;  Each oil definition is made of 2 consecutive lines:

; one for Absolute Viscosity  (uReyns, Reyns or lb/in2)

;       one for Pressure-Viscosity Coefficient (in2/lb, m2/N)

;

;  1st  Oil data line is given in the following sequence:

; Oil Name

; Absolute Viscosity Units (UREYN, REYN, CP)

; Temperature Units        (F,    C)

; Data Sets (Viscosity-Temperature)

;

;  2nd  Oil data line is given in the following sequence:

; Oil Name

; Pressure-Viscosity Coefficient Units  (IN2/LB, M2/N)

; Temperature Units       (F,      C)

; Data Sets (Pressure-Viscosity Coefficient-Temperature)

;

; Warning : the character "-" is a separator between Viscosity and Temperature

; Pressure-viscosity coefficient and Temperature

;

ISO 1500, UREYN,  F,  200-100,   90-120,   47-140,   25-160,   15-180,  9.5-200,  6.1-220,  4.3-240,    3-260

ISO 1500, IN2/LB, F,  2.2-100,  1.9-125, 1.75-150, 1.61-175, 1.48-200, 1.35-225, 1.25-250, 1.15-275, 1.07-300
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Rim - Material Data …
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*** HYGEARS MATERIAL FILE ***

;  This is comment line which is ignored

;  by HyGEARS. Comment lines should appear at the

;  beginning of the file, and start with a ";" semi-colon character.

;

;  Material data is given in the following sequence:

; Material Name

; Bending Strength

; Compressive Strength

; Strength units (PA, KPA, MPA, GPA, PSI, KSI)

; Young Modulus

; Poisson ratio

; Young Modulus units (PA, KPA, MPA, GPA, PSI, KSI)

; Hardness value

; Hardness units (BHN, HRC, HRB)

; Relative density (relative to water)

AGMA A-1          ,  200,  630, MPA, 200, 0.3, GPA, 180, BHN, 7.8

AGMA A-2          ,  250,  750, MPA, 200, 0.3, GPA, 240, BHN, 7.8

AGMA A-3          ,  280,  870, MPA, 200, 0.3, GPA, 300, BHN, 7.8

AGMA A-4          ,  320, 1050, MPA, 200, 0.3, GPA, 360, BHN, 7.8

AGMA A-5          ,  340, 1150, MPA, 200, 0.3, GPA, 400, BHN, 7.8

AISI 4140         ,  270, 1175, MPA, 200, 0.3, GPA,  48, HRC, 7.8

AISI 4340         ,  290, 1125, MPA, 200, 0.3, GPA,  46, HRC, 7.8

NITR 135M         ,  295, 1250, MPA, 200, 0.3, GPA,  60, HRC, 7.8

2.5% CHRM         ,  415, 1300, MPA, 200, 0.3, GPA,  57, HRC, 7.8
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Bearing Data …

© Involute Simulation Softwares Inc. 2021



Bevel Gears …

P

E

Radial

Radial

G

Shaft Angle

Alignment

Gear Runout

Pinion Runout
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Spur / Helical Gears …
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General Data Page

Units Data Page
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Fonts Data Page

Graphics Data Page
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Reference Frames

Rotation Axes
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Colors Data Page

Display Data Page
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In HyGEARS, creating a new geometry is 

simple.

The New Geometry Definition Window offers 

basic input fields in which the required data is 

provided. 

The New Geometry can be processed at once, 

and saved in a file for later retrieval.

At every step, HyGEARS offers default values 

to ease creation.

Entries in yellow must be provided by the 

user.
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Bevel Gear Macro and Micro Geometry:

• Basic dimensions are established as per AGMA 2005.

• Initial machine settings are established from Basic dimensions and given cutter specs.

• Tooth dimensions are applied as per Depth and Addendum factors; thus, generated members are not 

checked for undercutting; profile shift is not modified if undercutting is present.

• Clearance is calculated on pinion and gear; 

• Contact Pattern is pre-developed:

– CP is Centered Length wise on Gear Tooth

– CP is Centered Depth wise on Gear Tooth

– Any Bias is ignored at this time

• Design is displayed for user evaluation.
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Bevel Gear Macro Geometry

Basic dimensions are based on AGMA 2005:

• Depth and Addendum Factors

• Clearance

• Outer Cone Distance

• Face Width

• Cutter Diameter

• Pitch Angle

• Addendum and Dedendum Angles
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Bevel Gear Macro Geometry

For  Hypoid gears:

Spiral Angle (based on Offset)

FApx-Xp (A)

RApx-Xp (B)

PApx-Xp (C) 

C-Xp      (D)

FC-Xp (E)
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Bevel Gear Macro Geometry

Tooth Taper (Zerol, Spiral Bevel, Hypoid):

Standard

Duplex = f (cutter radius)
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Bevel Gear Macro Geometry:

Dedendum Angle
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Straight, Zerol and Spiral Bevel Gears
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Hypoid Gears …
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Correction and RE
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Specify CMM data

Correction / Closed Loop

Reverse Engineering

P
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Corrective Machine Settings – i.e. Closed Loop - (like Gleason’s GAGE) and Reverse Engineering

CMM data is used to calculate changes in machine settings needed for the actual tooth surface to 

match the theoretical tooth surface.

Corrective Machine Settings/RE support:

• 1st order errors: spiral angle, pressure angle, tooth taper;

• 2nd order errors: crowning and tooth warp (bias);

• Roughing and Finishing;

• All FM and FH cutting processes, Straight bevel, Coniflex, Spur, Helical and Face gears.
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CMM Output converted to HyGEARS common format

HyGEARS tests if the data file is of  type:

• “Ram” / “Rfd”;

• “Gleason-Zeiss”;

• “Hoeffler”;

• “MdM”;

• “Klingelnberg-P”;

• “GAGE”;

• “Zeiss Gear Pro”;

• “Mitutoyo”;

• “HyGEARS”.
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If not HyGEARS type, then the file

must be converted to the HyGEARS 

format



The Surface Match algorithm (introduced in 1994) :

– Changes the machine settings of the selected member until the measurement surface 

statistics are within given tolerances;

– Uses the sensitivity of the error surface (difference between measurement and simulation) 

to chosen control parameters to iterate until the desired tolerances are met;

– Applies a Newton-Raphson based iterative process to solve objective functions.

Surface Match Algorithm for Correction / R.E.
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Pressure Angle Error:

Spiral Angle Error:

Crowning Error:

Surface Errors
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Warp (Bias) Error:

Taper Error:

Surface Errors
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Correction and RE

Corrective Machine Settings (Closed Loop): 1st time -> identify the reference Nominal Summary
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Correction and RE

Tolerance options on target values and tolerances; 

Order options on what is to be corrected;

Machine options on control parameters constraints;

Correction calculated changes in machine settings;

Expected Stats what HyGEARS expects after correction;

Errors point by point differences
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Correction and RE

Tolerance options on target values and tolerances; 

Order options on what is to be corrected;

Machine options on control parameters constraints;

Correction calculated changes in machine settings;

Expected Stats what HyGEARS expects after correction;

Errors point by point differences
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Correction and RE

Tolerance options on target values and tolerances; 

Order options on what is to be corrected;

Machine options on control parameters constraints;

Correction calculated changes in machine settings;

Expected Stats what HyGEARS expects after correction;

Errors point by point differences
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HyGEARS uses the Surface Match algorithm to Reverse Engineer existing tooth surfaces.

Reverse Engineering is useful to:

– identify the machine settings of existing gear sets for which the summaries are lost;

– analyze existing gear sets and identify the machine settings or provide a reference surface 

leading to quietness;

– diagnose the reason for a failure by simulating meshing and load sharing;

– optimize the Stock Distribution;

– use different cutters on a given geometry (Fixed Setting only);

– calibrate mechanical machines to pre-compensate for their inaccuracies;

– etc.

     

Reverse Engineering (RE)
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Build number
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Data Folders



Start HyGEARS

Fill in the Registration form: your name

your address

Watch the HyGEARS Copyright screen

Watch the HyGEARS Parent Window appear in the screen
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Import the Spa file

File->Open

Navigate to the proper folder

Select “Gleason SPA (*.Spa)”

Select “Summary for CNC.spa”

Look at the different display modes

TCA, LTCA, Geometry, etc. 

Save the imported geometry

File->Save As 

Name: “Summary for CNC.HyG”
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Start MS-Word; Experiment ^C (select a Child window: Copy 

the Child Window contents to the clipboard) and then Paste 

it into Word (^V) 

Experiment ^+ (Zoom In)

Experiment ^Z (Center and Fit Display)

Experiment ^R (Reference frames On/Off) and then 

Rotate/Zoom the Tooth Child Window display

Experiment ^F (toggle tooth flank)
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Open the Summary for CNC.HyG file

File->Open

Watch the CP-TCA Pre-Defined display

Create a Tooth Child Window

Display -> User

Graphics->Tooth->Tooth

Create a 2D Graph

Graphics->2D Graphs  (Click on Ok)
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Experiment the Rotation With the Mouse (left mouse button 

depressed) on the Tooth Child Window
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Left mouse button over grey area:

File menu

Right mouse button over grey area:

Graphics menu
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Experiment the Left Mouse Button   - call the File menu

Experiment the Right Mouse Button - call the Graphics menu
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Differences appear between the drawing and HyGEARS default tooth outlines.

Default tooth – as created / imported Requested tooth
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Use of the Blank function

“1”

“2”

“3”
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Select the Gear Summary Editor: “Gea” function button

1- Set the Back Angle to 90 deg.

2- Click on “Apply”
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3- Enter the requested OD: 52 [mm]

4- Click on “Apply”
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Blank Editor: “Blank” function button (Gear Group)

1- Enter the desired values

2- Click on “Apply”
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Pinion Summary Editor: “Pin” function button

1- Click on the check box to the right of the Outside Diameter input field;

2- Enter the desired Cropped OD;

3- Click on “Apply”
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Blank Editor: “Blank” function button (Pinion Group)

1- Click on the Cropped OD check box;

2- Enter the desired Cropped OD;

3- Click on “Apply”



© Involute Simulation Softwares Inc. 2021

Save your geometry under a different name to be able to compare
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Geometry as Created/Imported Geometry as Modified
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TCA as Created/Imported TCA as Modified



Gear ratio

Default name
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Enabled if geometry 

present in memory
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Angular input formats:

22.30.00     22.50
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Example: 9x37 Generated Spiral Bevel gear set

Gear tooth type: Generated

Pinion tooth type: Generated, Duplex Helical

Pinion Tooth Hand: Left

Gear Face Width: 30% of outer cone distance

Speed ratio: Approximately 4:1

Pinion Speed: 2000 RPM

Available diameter space: About  70 mm (2.75 in)

Power: 1 kW (1.3 HP)

Application: Power tool
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Example: 9x37 Generated Spiral Bevel gear set

Call the File-> New Geometry menu entry – Spiral Bevel

Click on Next >>

© Involute Simulation Softwares Inc. 2021



Example: 9x37 Generated Spiral Bevel gear set

Cutter Data Section:

Click on Next >>
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Example: 9x37 Generated Spiral Bevel gear set

Units Data Section:

Click on Next >> Click on Ok
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Example: 9x37 Generated Spiral Bevel gear set
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Example: 9x37 Generated Spiral Bevel gear set
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Example: 9x37 Generated Spiral Bevel gear set

Press the ^S (Save) keyboard combination and agree to the questions asked.

Contact Pattern Display of the 9x37a.dat Geometry
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Example: 9x37 Generated Spiral Bevel gear set

Click on the GSum function button:
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Example: 9x37 Generated Spiral Bevel gear set
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Example: Modifying the CP and TE 9x37 Generated Spiral Bevel gear set
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Example: Modifying the CP and TE 9x37 Generated Spiral Bevel gear set
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Example: Modifying the CP and TE 9x37 Generated Spiral Bevel gear set
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Example: Modifying the CP and TE 9x37 Generated Spiral Bevel gear set

© Involute Simulation Softwares Inc. 2021



Example: Modifying the CP and TE 9x37 Generated Spiral Bevel gear set
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Example: Modifying the CP and TE 9x37 Generated Spiral Bevel gear set

Click on Ok to keep the changes
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Example: 9x37 Non-Generated Spiral Bevel gear set

Gear tooth type: Non-Generated

Pinion tooth type: Generated, Duplex Helical

Pinion Tooth Hand: Left

Gear Face Width: 30% of outer cone distance

Speed ratio: Approximately 4:1

Pinion Speed: 2000 RPM

Available diameter space: About 70mm (2.75 in)

Power: 1 kW (1.3 HP)

Application: Power tool

© Involute Simulation Softwares Inc. 2021



Example: 9x37 Non-Generated Spiral Bevel gear set

Call the File-> New Geometry menu entry – Spiral Bevel
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Example: 9x37 Non-Generated Spiral Bevel gear set

Click on Next >>  twice and Ok

© Involute Simulation Softwares Inc. 2021



Example: 9x37 Non-Generated Spiral Bevel gear set
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Example: 9x37 Non-Generated Spiral Bevel gear set
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Speed ratio
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Angular input formats:

22.30.00     22.50
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Gear ratio
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Gear ratio
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Gear ratio
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Gear ratio
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In HyGEARS, Straight-Bevel gear Blank shapes come in 2 flavors: 

• “Differential” they usually forged or injection molded; the Front 

angle is zero degree; TE can be larger such as to be more tolerant. 

• “Standard” where the Front angle equals the pitch angle; TE can 

be lesser, such as to be quieter.

Both variants can be cut on a 5 Axis CNC machine using: 

• a Conical Side Milling Tool (or CoSIMT), 

• an End Mill or 

• a Ball Mill. 
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Gear ratio
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Click on Next >>  and Ok



Creating a “Differential” Straight Bevel gear set / 2

© Involute Simulation Softwares Inc. 2021



Creating a “Standard” Straight Bevel gear set

Speed ratio
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Click on Next >>  and Ok



Creating a “Standard” Straight Bevel gear set / 2
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Tooth – M/C -> Cutting Machine Child Window -> 5 Axis CNC manufacturing

Overview:

HyGEARS integrates a 5Axis Post-Processor that can generate CnC part programs to cut any HyGEARS 

supported gear type on any 5 Axis CnC machine.

The part programs, based on the exact tooth definition,  need no further intervention and can be uploaded 

directly to any 5Axis CnC machine.

Tool and machine movements are displayed in 3D, can be rotated in any direction for better viewing, and can 

be animated or single stepped to allow visualization and collision detection throughout the tool path.

The use of the Post-processor is easy, intuitive, and reflects the actual work done on the shop floor.

The Post-processor supports machine architectures of “BA”, “BC”, “AB” and “AC” types, where :

• the A axis rotates about the X axis

• the B axis rotates about the Y axis

• the C axis rotates about the Z axis

Specific machines with special kinematics can be created and saved for later use: the translation and rotation 

axes can be renamed, and their positive direction can be inverted.

Typical tools include Face Milling, Coniflex™ dish, CoSIMT (i.e. Conical Side Milling Tool), End Mill and Ball 

Mill cutters. A tool box for each tool type can be created by the users to suit their needs.
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Main features of the Post-Processor:

• supports “AB”, “AC”, “BA” and “BC” architecture machines;

• supports GCodes, Heidenhain, Siemens, Okuma, Mazak and Fanuc controllers;

• supports Traori (Siemens), TCPM (Heidenhain) , TCP (Fanuc) and TCPC (Okuma);

• allows creation of specific 3, 4, 5 Axis machines from the 4 basic architectures; specific machines can be fully 

customized by the user to reproduce exactly the machine implementation;

• offers 10 pre-defined cutting cycles for CoSIMT, End Mill and Ball Mill tools; and 4 pre-defined cutting cycles 

for Face Mill tools (single roll/double roll);

• CoSIMT and End Mill cutting edges can be linear or circular (to cut a Face Gear for example);

• allows single pass roughing / multi-pass semi-finishing and finishing for CoSIMT, End Mill and Ball Mill tools;

• allows the generation of a protuberance in the fillet;

• the tool path is easily customized by the user in order to optimize both cycle time and product quality;

• allows automated / single stepping animation of the tool and work piece through the cutting cycle; 

• allows the display of the supporting arbor and the machine head to detect potential collisions;

• allows the creation of “Operations” which define a given task; Operations can be re-used on different gears;

• allows the creation of “Processes” which are a series of “Operations” in a given order; Processes can thus 

generate a complete single file part program including roughing and semi-finishing of the tooth flank and fillet 

using different tools.

Part Programs:

• can be in CSV (comma separated values) format for import in Excel;

• can include or exclude comments describing the operations performed;

• can be for Face Milling cutters (spiral bevel gears), Dish type cutters (Coniflex -™ The Gleason Works -

gears), CoSIMT (such as made by Ingersoll Rand, Sandvik, PTR-TEC), End Mill, Ball Mill cutters.
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A-C machine architecture:

➢ X, Y, Z translations (on the tool and/or work piece)

➢ Tilting Turntable about X axis: angle A

➢ Rotation about work axis: angle C

XY

C

Z

A
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A-B machine architecture:

➢ X, Y, Z translations (on the tool and/or work piece)

➢ Tilting Turntable about Y axis: angle B

➢ Rotation about work axis: angle A

Y

X

A

Z

B
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B-C machine architecture:

➢ X, Y, Z translations (on the tool and/or work piece)

➢ Tilting Tool about Y axis: angle B

➢ Rotation about work axis: angle C

ZY

B

X

C
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B-A machine architecture:

➢ X, Y, Z translations (on the tool and/or work piece)

➢ Swiveling Tool about X axis: angle A

➢ Tilting Tool about Y axis: angle B

X

Y

A

Z

B



Conversion: To generate a part program, HyGEARS converts the movements of the conventional

cutter in a conventional machine into movements of a Face Mill, Coniflex™ dish,

CoSIMT, End Mill or a Ball Mill tool in a 3, 4, 5 Axis CnC machine where:

• the relative orientation between the ref. frames of tool and work in the conventional machine 

are maintained in the CnC machine;

• the relative position between the ref. frames of tool and work in the conventional machine are 

maintained in the CnC machine.

The figure to the right shows a Face 

Mill cutter (pink) and a CoSIMT (green) 

with coincident cutting edges.

The HyGEARS Post Processor tracks 

the movements of the Face Mill cutter 

in the conventional machine and 

converts them to CoSIMT movements in 

a 5Axis CnC machine.

The same approach is applied to all 

tools and gear types.
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Interface: Several Tabs display different options and information

Machine – Tool - Display 

selection

Cutting Cycle - Output 

selection

Expected Cycle Time 

breakdown

Expected Surface Quality 

metrics

Workpiece Support 

definition

Tool definition

Expected Stock 

distribution

Process definition

Operation definition



© Involute Simulation Softwares Inc. 2021

Machine/Tool: Machine and Tool selection; display options

Machines are optional; 

• Generic type

• Specific type

Cutting Tools are 

optional; they are user 

defined.

Display switches control 

what is shown on screen..

Apex Location: used in 

“Machine” coordinates
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Machine/Tool: The Apex Location is used in Machine coordinates to compensate for turntable tilt
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Cycle: Selection of Output, Stock, Feed, Clearances, Tooth area, and Cutting Cycle

Output Format: allows 

selecting wanted or 

unwanted features

Controls step depth, cycle 

coarseness, Toe and Heel 

clearances, gap indexing.

Tool movement types 

during cutting cycle
Targeted tooth region: 

• Fillet, 

• Flank, 

• Combined, 

• Chamfering

# Gaps skipped between 

2 cuts. If “/X” where X = 

1, 2, …, n, then 

• Start Gap = 1

• End Gap  = Z

Distributed about one 

central tooth gap

Cuts the Complete Gap 

or

Cuts all the Convex flanks 

and then cuts all the 

Concave flanks.

•Machine: XYZ ABC

•Work: XwYwZw ABC

•Traori: XwYwZw ijk
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Metrics: Profile-wise step depth, slot width, expected surface quality

Profile-wise Steps

Considered Tooth flank

Step by step breakdown
Peak-Prof.

Ramp-Ang.
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Metrics: Length-wise step depth, slot width, expected surface quality

Length-wise Steps

Considered Tooth flank

Step by step breakdown
Flat-Prof.
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Cycling Time: Flank by flank operation Cycling time breakdown

Concave Tooth Flank

Convex Tooth flank

Tool Feeds & Speeds

Complete Cycle

For Each Tooth Flank

• Line: each line in the face 

width direction

• Face: the complete tooth 

flank

• Plunge/Retract: time needed 

to go in and out of the slot;

• Return: return trip time 

(when applicable)

For the current cycle

• Total/Slot: total time per slot

• Indexing: indexing time

• Operation: time needed to 

complete the operation
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Arbor: Blank supports on the machine.

Work body between Heel 

arbor and Heel fillet

Heel arbor definition

Toe arbor definition
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Tools: HyGEARS offers 6 different tools: Face Mill cutter (spiral bevel, Zerol, hypoid  gears)

Dish cutter     (Coniflex™ gears)

CoSIMT            (all gear types)

End Mill (all gear types)

Ball Mill (all gear types)

Probe (CMM) (all gear types; for measurement)

Photos courtesy of PTR-TEC.de
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Tools: Each tool type is described in a dedicated data page where the defining dimensions are 

entered by the user. The 30 character-long tool name is user defined.

The tools can be saved for re-use and are specific to users, i.e. they are not distributed with 

HyGEARS. Hence, proprietary information remains proprietary.

Definition of an 8mm Bull Nose
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Ball Mill Definition: Tool dimensions, reference (tools are user defined).

Tool dimensions

Tip reference warning

Tool name Tool list

Tooth reference dims.

Tool feeds & speeds

Tool ID
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End Mill Definition: Tool dimensions, reference (tools are user defined).

Tool dimensions

Tip reference warning

Tool name Tool list

Tooth reference dims.

Tool feeds & speeds

Tool ID
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CoSIMT Definition: Tool dimensions, reference (tools are user defined).

Tool dimensions

Tool name
Tool list

Tooth reference dims.

Tool feeds & speeds

Tool ID



CoSIMT Definition : CoSIMT tools can have circular cutting edges which allow the generation 

of tooth profiles with concave curvature, such as Face Gears.

Definition of a CoSIMT
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Face Mill Definition: Tool dimensions, reference (tools are user defined).

Face Mill cutter definition

• the Face Mill cutter used on the 5Axis CnC 

machine can be defined and saved;

• cutter Diameter, Blade angles, Edge Radii, and 

Point Width are those described in the Summary 

Editor (see below).
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Face Mill Definition: Tool dimensions, reference (tools are user defined).

Tool dimensions

Tool name Tool list

Tool feeds & speeds

Holder Definition

Tool ID
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Coniflex Definition: Tool dimensions, reference (tools are user defined).

Tool dimensions

Tooth reference dims.

Equivalent CoSIMT

Tool name Tool list

Tool feeds & speeds

Tool ID
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Coniflex Definition: DXF export.
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Probe Definition: Tool dimensions, reference (tools are user defined).

Tool dimensions

Tool name Tool list

Tooth reference dims.

Tool feeds & speeds

Tool ID

To use an existing 

Measurement (*.Mes) or 

Theoretical (*.Teo) CMM 

data file
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Operation: Saves all switches and choices such as to be reusable.

Operation ID

Used for the name of the 

part program and 

sub- programs

Programmed tool change

If 1st Gap = 0, then no 

Tool change occurs.

Operation name Operation list

Operation switches

May be turned On/Off in 

the Output Format

Tool feeds & speeds

Origin from tool, and are 

overridden here.

Main and sub programs in 

same file

Imposes the tool return 

path

Vc and fz; used to 

estimate required torque 

& power.
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Operation: The Operations page allows saving combinations of Machine, Tool and Cutting Cycle 

selections, for the current geometry, under one identifier such as to be able to use the 

same combinations with different geometries, or when defining Processes.

Operations Tab

• an Operation is specific to a geometry, i.e. 

it is saved in the “Operations.fil” file 

stored in the current geometry’s folder;

• the Save / Delete buttons conserve and 

erase the selected operation;

• the Import button allows importing 

Operations from other geometries; thus, 

Operations can be re-used;

• the Output button generates the part 

program for the selected Operation;

• Tool Changes can be imposed at specified 

tooth gaps;

• Several Switches can be imposed to any 

given operation.
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Operations: The STEP button displays a selection window where one Flank and one Fillet 

operation are selected, and then combines the selected operations in one STEP file 

which can be read by any CAD-CAM software, such that the actual shape of the tooth 

can be exported for assessment at any intermediate manufacturing step.

Operations: STEP output Final tooth: 0 Flank Stock, -1.5 mm Fillet Stock
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Process: Organizes Operations in a user defined sequence.

Process ID

Used for the name of the 

part program and sub 

programs

Available Operations

Process name Process list

Selected Operations for 

the current Process

All Main and sub 

programs in same file

Overrides the No 

Comments switch for all 

Operations of a Process

Overrides the Apex 

Location for all 

Operations of a Process

Right Click opens menu
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Processes: A Process is an ordered sequence of Operations in which a Main, or Calling, program 

is generated which calls the selected Operations in the requested order. 

For example, right column in the figure below, the Main program would call Operation 

“Rough-Mpass-0.8 [mm] …” first, and then Operation “Rough-Fil-Mpass …”

Processes Tab

• A Process is specific to a geometry, i.e. it is 

saved in the “Processes.fil” file stored in 

the current geometry’s folder;

• A Process can contain any number of 

operations – the controller’s memory being 

the practical limit;

• the Save / Delete buttons conserve and 

erase the selected Process;

• the Import button allows importing 

Processes from other geometries;

• the Output button generates the complete 

part program for the selected Process;

• All Switches imposed in any given 

operation appear in each step of the 

Process.



Machines: 4 basic CnC machine architectures are available: BC, AC, AB and BA (bottom left 

figure); plus 3 and 4 Axis machines.

Any specific machine can be derived from the basic types using the HyGEARS machine 

editor (bottom right figure).
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Machine Selection
Machine Editor
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Display: Several options allow selective information display. These include:

• the Machine Head,

• the Work Arbor and support,

• the Target Grid, where the target coordinates are displayed in wire frame mesh,

• the Target Volume which will be removed by the selected operation,

• the Tool Path.

Display of the Target Grid (beige) and Volume (light blue)
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Display: Example of Tool Holder and Work Arbor with CoSIMT and 1.2 mm module hypoid pinion.

Display of the Arbor and Tool Holder
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Display: Detection of Gouging interference (tool back side contact with opposite tooth flank): 

HyGEARS can determine, and display where, if any Gouging occurs such as to alert the  

user of potential profile mutilation; valid for CoSIMT, End Mill, Ball Mill tools.

Display of Gouging points with Pink crosses

Current cutting point
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Cycle Options for CoSIMT, End Mill and Ball Mill tools

• Stock feed along the face width 

(#Facewidth Pts) and tooth depth (#Steps)

• Step# where cutting starts and ends (Start 

/ End)

• Tool retraction at end of cycle (Retract 

Factor, based on Heel tooth depth)

• Whether the tooth is digitized with 

constant roll angle or constant radius 

increments (Constant D-Radius)

• Whether the contact point moves along the 

tool cutting edge (Moving Contact Pt)

• Roughing and Finishing cycles

• Toe and Heel clearances, to plunge the 

tool full speed

• Tip, Toe and Heel chamfering

• Indexing sequence in order to spread tool 

wear and thermal load over non 

sequential tooth Gaps (Skip#).

Cycles: Cutting cycles can be extensively tailored to user preferences, depending on tool choice.
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Cycles: CoSIMT, End Mill, Ball Mill

Cycles for CoSIMT, End Mill and Ball Mill tools

• CoSIMT tools can rough tooth flanks and fillet;

• CoSIMT, End Mill and Ball Mill tools can finish

tooth flanks;

• Bull Nose, End Mill and  Ball Mill tools can 

finish the fillet, and a protuberance can be 

imposed in the form of negative Stock;

• End Mill can Chamfer (i.e. deburring) tooth Tip;

• Positive and Negative stock can be used;

• Toe and Heel clearances can be imposed;

• The Indexing Sequence can be selected.
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Cycles: Constant D-Radius: checked: constant radial steps; insensitive for Z > 25

un-checked: constant roll-angle steps – improved surface near fillet

better for Z < 20

Constant D-Radius Constant D-Roll
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Cycles: Moving Contact Pt: checked: contact point moves along End Mill edge; better Finish

un-checked: contact point always at End Mill tip: more tool wear

Moving Contact Pt: Finishing Fixed Contact Pt: Roughing
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Cycles: HyGEARS offers 7 cycles for Face Mill cutters and 1 cycle for the Coniflex™ dish cutter.

Cycles for Face Mill cutters / Semi-CompletingCycles for Face Mill cutters / Completing
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Cycles: Face Mill Cutter – Completing cutting processes

Cycles for Face Mill cutters

• can be Single Roll/Double Roll;

• Double Roll plunges the cutter to full depth 

between the start and end of the 1st roll, and then 

generates full depth on the 2nd roll;

• can be Toe to Heel or Heel to Toe;

• the use of Toe/Heel clearances allows 

progressive cutter entry/retract for better tool 

life (see the Target Volume in light blue below);

• the Indexing Sequence allows spreading tool 

wear and thermal load over non-consecutive 

tooth slots.
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Cycles: Face Mill Cutter – Fixed Setting / Semi-Completing cutting processes

Cycles for Face Mill cutters

• xx / yy: 1st part is Convex flank; 2nd part is 

Concave flank

• the use of Toe/Heel clearances allows 

progressive cutter entry/retract for better tool 

life (see the Target Volume in light blue below);

• Negative Finish stock pushes the cutter In such 

as to compensate for tool wear;

• the Indexing Sequence allows spreading tool 

wear and thermal load over non-consecutive 

tooth slots.
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Cycles: HyGEARS offers 14+ different cutting cycles for CoSIMT, End Mill and Ball Mill tools.

Cycles for CoSIMT, End Mill and Ball Mill tools
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Cycles: Finishing cycles for CoSIMT, End Mill and Ball Mill tools.

Finishing Cycles for CoSIMT, End Mill and Ball Mill tools

• Fillet/Root, Tooth Flank, Combined, Toe, 

Heel and Tip Chamfer (Deburring) are 

different operations;

• They can be cut Slot by Slot or Flank by 

Flank, depending on machine selection, 

work size, and how much travel is required 

by the machine or tool between tooth 

flanks;

• Finishing cycles need not be the same on 

both tooth flanks;
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Cycles: Example: End Mill tool, Toe-Heel-Toe (IB-Side) / Heel-Toe-Heel (OB-Side)

End Mill cycles

• Cutting cycles can be different for each tooth 

flank (IB-OB, Left-Right);

• a cutting cycle may start on the IB and finish on 

the OB (Left-Right for non spiral-bevels);

• for example, with the selections made in the left 

figure, given the IB cycle ends at Heel, unless 

otherwise dictated it could make sense to start 

the OB cycle at Heel to reduce cycle time (the 

tool path is the red line in the figure below).
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Cycles: Example: End Mill tool, Fillet

Fillet cycles

• Fillet finishing is integral to tooth flank finishing 

when using a Face Mill cutter since the tool 

sweeping movement generates the fillet;

• Fillet finishing is done in a distinct operation 

when using an End Mill or Ball Mill tool; 

• negative Stock can be imposed to produce a 

protuberance; 

• the tool can be tilted away from the tooth to 

avoid interference;

• Fillet finishing uses the same cycles as for Flank 

finishing.
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Cycles: Example: tapered End Mill tool, IB-OB O-Shaped / OB-IB O-Shaped

IB-OB O-Shaped cycle

• only one starting flank can be selected, the other 

being slave;

• for IB-OB, the cutting cycle takes a pass along 

the face width on the IB and switches to the OB 

for return; the cycle then switches back to the IB 

and takes one step depth wise before starting 

over again;

• can be a real time saver when used with a 

Tapered End Mill or a CoSIMT.
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Cycles: Example: CoSIMT tool, Rock-Me (Babe)

Rock Me (babe) cycle

• the cycle starts at IB Toe-Tip, generates depth 

wise to the Fillet, switches to the OB and 

generates from Fillet to Tip, advances along the 

OB face width, generates depth wise along the 

OB side to the Fillet, switches to the IB and 

generates till Tip, advances along the IB face 

width, and starts over until Heel is reached;

• this process is well suited to CoSIMT and 

finishing in one operation.

Tool Path
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Cycles: Roughing cycles for End Mill and Ball Mill tools.

Roughing Cycles for End Mill and Ball Mill tools

• Fillet/Root and Tooth Flank are different 

operations;

• They can be cut Slot by Slot or Flank by 

Flank, depending on machine selection, 

work size, and how much travel is required 

by the machine or tool between tooth 

flanks;

• Roughing cycles need not be the same on 

both tooth flanks;

• Center Slot cuts a through in the center of 

the gap;

• MultiPass is a Slot by Slot operation; it 

makes an even number of passes per Step, 

based on slot width and tool diameter; the 

number of passes is calculated at each 

Step; allows greater tool feeds over Center 

Slot because the tool is never captive in a 

through. 
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Cycles: Roughing cycles for CoSIMT tools.

Roughing Cycles for CoSIMT tools

• Fillet/Root and Tooth Flank are different 

operations;

• They can be cut Slot by Slot or Flank by 

Flank, depending on machine selection, 

work size, and how much travel is required 

by the machine or tool between tooth 

flanks;

• Roughing cycles need not be the same on 

both tooth flanks;

• Center Slot cuts a through in the center of 

the gap;

• MultiPass is a Slot by Slot operation; it 

makes an even number of passes per Step, 

based on slot width and tool diameter,  the 

number of passes is calculated at each 

Step; allows greater tool feeds when 

compared to Center Slot;

• For Fillet roughing, only Center Slot is 

available;
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Tool Reference Point: the Tool Length to be entered in the 5Axis machine controller depends on 

the location of the Tool Center Point (TCP), as follows.

CoSIMT : TCP (located @ mid P.Width) Face Mill Cutter: TCP (in the plane of blade tips)



© Involute Simulation Softwares Inc. 2021

Tool Reference Point: End Mill / Ball Mill tools: reference can be given at TCP or Tip.

Ball Mill : TCP and Tip End Mill: TCP and Tip



© Involute Simulation Softwares Inc. 2021

Tool Reference Point: Coniflex™ dish type cutter: TCP.

Coniflex Dish Reference Point
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Part Reference Point: The reference point on the work piece changes with geometry type; it is 

tool independent.

Work piece reference point:

Mid-face width (on the Axis)

Spur/Helical/Beveloid/Herringbone gears: BC type machines
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Part Reference Point: The reference point on the work piece changes with geometry type; it is 

tool independent.

Work piece reference point:

Mid-face width (on the Axis)

Spur/Helical/Beveloid/Herringbone gears: AC-AB type machines
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Part Reference Point: Straight Bevel / Spiral Bevel / Zerol / Coniflex gears.

Work piece reference point:

Pitch cone Apex

Straight Bevel/Spiral Bevel/Zerol/Coniflex gears
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Part Reference Point: Hypoid gears.

Work piece reference point:

Crossing Point (Xp)

Hypoid  gears
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Part Reference Point: Face gears.

Work piece reference point:

Pitch Plane (on the Axis)

Face gears
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Output: The Output button instructs HyGEARS to read the selected user choices, generate the 

part program and send the output to a Text Results window.

Part program Output

A part program comprises:

• a Header, in which user selections, 

machine settings and tool definition are 

listed; this is optional at output time using 

the “No comment lines” switch;

• a Preamble, specific to the selected 

machine, where machine code desired by 

the operator is added automatically;

• the Indexing Sequence, where each tooth 

slot calls the actual cutting program in the 

specified sequence order;

• the actual cutting program with tool path 

coordinates;

• Work Coordinates indicate that X, Y and Z 

are in work piece coordinates, and that 

angles A, B, C are machine angles;

• Traori, TCPM, TCP and TCPC indicate 

that the unit vector of the tool axis is 

provided along with X, Y and Z  in work 

piece coordinates.
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Output: the Header lists user selections, machine settings and tool definition.

Output: Header – 1st part Output: Header – 2nd part
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Output: Indexing Sequence: indexes the work piece axis in the specified sequence.

Output: Header – Indexing Sequence
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Output: Tool path coordinates: the actual tooth flank cutting commands.

Output: Tool path coordinates (with comments)



Closed Loop: Integral to HyGEARS

A) Corrective Machine Settings must have been applied to the desired part;

A: Calculating Corrective Machine Settings
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Closed Loop: B) Select the desired Correction iteration

B: Selecting the desired Correction
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Closed Loop: C) Work in 5Axis as usual

C: Working in 5Axis with 1st Correction “[Corr #1]“
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Example: Create a sequence of Operations to:

• Rough the Flanks – 0.040 mm Stock

• Rough the Fillet – 0.020 mm Stock

• Finish the Fillet – 0 Stock

• Finish the Flanks – 0 Stock

Use the imported 11x39 spiral-bevel gear set
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Example: Go into Machine mode:

• Click on “5Axis”, Gear group

• “Machine/Tool” tab

• In “Specific Machine”, select “Mikron GF [Heidenhain]”

• Select “End Mill” tool

• Select the “Display” options

• Click on “Apply”
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Example: Go into Machine mode:

• Click on “5Axis”, Gear group

• Select “Machine/Tool” tab

• In “Specific Machine”, select “Mikron GF [Heidenhain]”

• Select “End Mill” tool

• Select the “Display” options

• Click on “Apply”
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Example:

• Select “End Mill” Tab

• Enter the data for the X6562060 tool (below)

• Click on “Apply”, click on “Save”
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Example:

• Enter the data for the M45713080 tool (below)

• Click on “Apply”, click on “Save”
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Example: 1st Operation: Rough the Flanks – 0.040 [mm] Stock with M45713080 tool

• Select the “Cycle” Tab

• Maximum Step depth is 0.1 [mm] (from tool manufacturer)

• Make the selections as below, Click on “Apply”

• Check the Metrics for Step Depth: too large => Increase #Steps
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Example: 1st Operation: Rough the Flanks – 0.040 [mm] Stock

• Select the “Cycle” Tab

• Increase #Steps to 25; Click on “Apply”

• Check the Metrics for Step Depth: Ok this time
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Example: 1st Operation: Rough the Flanks – 0.040 [mm] Stock

• Select the “Cycling Time” Tab

• Operation time ~ 36 min.
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Example: 1st Operation: Rough the Flanks – 0.040 [mm] Stock

• Select the “Operation” Tab

• Enter the data as shown below

• Click on “Apply”; click on “Save”
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Example: 1st Operation: Rough the Flanks – 0.040 [mm] Stock

• Visualize your Operation;

• “Anim” and / or “+/-”; Zoom in  / out for better view
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Example: 1st Operation: Rough the Flanks – 0.040 [mm] Stock

• Click on “Output” to generate the part program

• Click on File->Save to save your program
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Example: 2nd Operation: Rough the Fillet – 0.030 [mm] Stock with X6562060 tool

• Select the “End Mill” Tab; select the X6562060 tool

• Maximum Step depth is 0.03 [mm] (from tool manufacturer)

• Make the selections as below, Click on “Apply”

• Check the Metrics for Step Depth: too large => Increase #Steps
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Example: 2nd Operation: Rough the Fillet – 0.020 [mm] Stock

• Select the “Cycle” Tab

• Increase #Steps to 15; Click on “Apply”

• Check the Metrics for Step Depth: Ok this time
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Example: 2nd Operation: Rough the Fillet – 0.020 [mm] Stock

• Select the “Cycling Time” Tab

• Operation time ~ 16 min.
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Example: 2nd Operation: Rough the Fillet – 0.020 [mm] Stock

• Select the “Operation” Tab

• Enter the data as shown below

• Click on “Apply”; click on “Save”
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Example: 2nd Operation: Rough the Fillet – 0.020 [mm] Stock

• Visualize your Operation;

• “Anim” and / or “+/-”; Zoom in  / out for better view
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Example: 2nd Operation: Rough the Fillet – 0.020 [mm] Stock

• Click on “Output” to generate the part program

• Click on File->Save to save your program
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Example: 3rd Operation: Finish the Fillet – 0.0 [mm] Stock with X6562060 tool

• Select the “End Mill” Tab; select the X6562060 tool

• Maximum Step depth is 0.03 [mm] (from tool manufacturer)

• Make the selections as below, Click on “Apply”

• Check the step depth in the “Metrics”tab; Ok
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Example: 3rd Operation: Finish the Fillet – 0.0 [mm] Stock

• Select the “Cycling Time” Tab

• Operation time ~ 16 min.
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Example: 3rd Operation: Finish the Fillet – 0.0 [mm] Stock

• Select the “Operation” Tab

• Enter the data as shown below

• Click on “Apply”; click on “Save”
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Example: 3rd Operation: Finish the Fillet – 0.0 [mm] Stock

• Visualize your Operation;

• “Anim” and / or “+/-”; Zoom in  / out for better view
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Example: 3rd Operation: Finish the Fillet – 0.0 [mm] Stock

• Click on “Output” to generate the part program

• Click on File->Save to save your program
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Example: 4th Operation: Finish the Flank – 0.0 [mm] Stock with M45713080 tool

• Select the “End Mill” Tab; select the M45713080 tool

• Flat-Prof deviation < 2 um

• Make the selections as below, Click on “Apply”

• Check the “Flat-Prof” in the “Metrics” tab; ~ 0.1 um -> Ok
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Example: 4th Operation: Finish the Flank – 0.0 [mm] Stock

• Select the “Cycling Time” Tab

• Operation time ~ 23 min.
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Example: 4th Operation: Finish the Flank – 0.0 [mm] Stock

• Select the “Operation” Tab

• Enter the data as shown below

• Click on “Apply”; click on “Save”

© Involute Simulation Softwares Inc. 2021



Example: 4th Operation: Finish the Flank – 0.0 [mm] Stock

• Visualize your Operation;

• “Anim” and / or “+/-”; Zoom in  / out for better view
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Example: 4th Operation: Finish the Flank – 0.0 [mm] Stock

• Click on “Output” to generate the part program

• Click on File->Save to save your program
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Example: Save the Geometry to include the name of the current Operation

Total Process time:

• 1) Rough Flank: ~ 26 min

• 2) Rough Fillet: ~ 16 min

• 3) Finish Fillet: ~ 16 min

• 4) Finish Flank: ~ 23 min

Total: ~ 1.35 Hour

Effect: ~ 2.03 Hour (Total x ~1.5)
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Example: Create a Process

• Select the “Process” tab

• Select each Operation in the desired sequence and move to Process Content

• Ensure “Internal Subroutine”

• Give a Name and ID to the Process

• Click on “Apply” and “Save”
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Example: Create a Process

• Click on “Output” to get a complete Process in 1 file

• Click on “File->Save” to save the Process file
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Sample Result 1: 13x37 6.5 mm module, hypoid gear set: soft-finish. 

Contact Pattern checks show perfect agreement with HyGEARS’ prediction.

Actual Contact Patterns

HyGEARS Contact Patterns
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• Pinion Fixed Setting – Generated

• Gear Spread Blade – Generated 

• Cut on DMU65 Monoblock (AC type 

machine)

• Roughing : CoSIMT 

• Pre-Finishing : Bull Nose End Mill

• Hard finish :  Tapered End Mill

13x37 hypoid gear pair on the VH tester

Actual Contact Pattern 

Pinion OB

HyGEARS’ 

Predicted Contact Pattern 

Pinion OB

Sample Result 1: 13x37 6.5 mm module, hypoid gear set: hard-finish. 

Contact Pattern check shows perfect agreement with HyGEARS’ prediction.
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Sample Result 1: 13x37 6.5 mm module, hypoid gear set: Pinion CMM output after hard-finish 

shows negligible deviations between actual and HyGEARS’ theoretical.
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Sample Result 1: 13x37 6.5 mm module, hypoid gear set: Gear CMM output after hard-finish 

shows negligible deviations between actual and HyGEARS’ theoretical.
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Sample Result 2: 26x26, 1.5 mm module, duplex helical spiral-bevel pinion cut using a Face 

Mill cutter.

Pinion CMM output after soft cut show a combination of pressure and spiral 

angle errors, plus some surface bias and lengthwise crowning.
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Sample Result 2: GAGE’s calculated Correction data and expected residual errors after re-cut 

show negligible pressure and spiral angle errors, but crowning will remain on 

the Concave tooth flank.
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Sample Result 2: HyGEARS’ calculated Correction data and expected residual errors after re-

cut show negligible pressure and spiral angle errors, and crowning on the 

Concave tooth flank disappears.
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Sample Result 2: CMM results after the 1st corrective cycle appear below. As expected, 

crowning remains in the GAGE corrected tooth while it is not visible in the 

HyGEARS corrected tooth.

In both the GAGE and HyGEARS corrected teeth, spiral and pressure angle 

errors have been eliminated.

GAGE correction HyGEARS correction
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1. HyGEARS’ tooth flank generation and TCA calculations match Gleason’s CAGE and 

Klingelnberg’s KIMoS; therefore, the reference topography in HyGEARS is the exact tooth 

definition;

2. HyGEARS designs gear set geometries, i.e. the machine settings for all HyGEARS supported 

geometries are calculated and a Summary is created;

3. Geometries can be imported from Gleason SPA, KIMoS ND and BECAL ND files; 

4. Spiral bevel cutting processes such as Face Milling and Face Hobbing are integral to HyGEARS;

5. Geometries can be analyzed unloaded and loaded for contact and tooth fillet stresses;

6. 5Axis CnC machine Post-Processing, i.e. the generation of a part program “machine ready”, is 

integral to HyGEARS;

7. Part programs are generated in reference to the exact tooth surface definition (rather than an 

interpolated surface as is the case with the many other CAM softwares);

8. Part program generation is based on a wide range of user selected cycle features;

9. Any 5Axis CnC machine architecture can be accommodated; current architectures include “AB”, 

“AC”, “BA” and “BC”; any controller can be accommodated; current controllers include 

GCodes, Siemens, Heidenhain and Fanuc;

10. Part programs can be in Machine coordinates, Work piece coordinates with axis angles, or Work 

piece coordinates with tool axis vector (Traori, TCPM and TCP);
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11. Users can define their own tool box for Face Mill, CoSIMT, End Mill and Ball Mill tools;

12. Cutting Cycles include Slot by Slot and Flank by Flank, both for tooth flank and fillet; tip 

chamfering is available;

13. Animations and single stepping allow the visualization of tool movements and the verification of 

tool paths and possible interference;

14. A “Metrics” function gives an estimate of the deviations between the theoretical tooth flank and 

the “flats” and “peaks” created by the discrete movements of the tool; thus, the # of depth wise and 

face width steps can be optimized to minimize “flats”, “peaks”and cycle time;

15. Toe and Heel clearances allow smooth tool entry and exit, and full speed tool plunge;

16. “Stock” allowance is available for roughing and finishing;

17. A “Roughing mode” moves the selected tool in the center of the gap to quickly remove as much 

material as possible;

18. “Operations”, including all user selections for a given task, may be saved for later re-use;

19. Closed Loop, also called Corrective Machine Settings, is integral to HyGEARS and allows the 

seamless manufacture of gears to the required tolerances.

20. The HyGEARS Closed Loop corrections match (and in some respect are better than) those of 

Gleason’s GAGE.



HyGEARS allows the direct input of 

existing Face Hobbing summaries

through the Existing Geometry Definition 

Window coupled to the Geometry 

Summary Editor.

The Existing Geometry Definition 

Window offers input fields and 

navigation tools to input the needed 

parameters.

The Existing Geometry can be processed 

at once, and saved in a file for later 

retrieval.
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The displayed geometry;

Teeth and machines;

Kinematics and Contact Pattern;

Surface measurement

Kinematic results in 2D Graphs

Complete Summary macro function

Finite Element Meshing / Finite Strips.
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Interpolation Options (with Error Surface)
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Gearing Primitives

  

HPSTC 

LPSTC 

  

Pitch Point 

Pinion Pitch Cone 

Gear Pitch Cone 
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LTCA Editor

Stiffness Calculation:

- Westinghouse formula,

- Nakada formula,

- Finite Strips (option).

Strength Calculation:

- AGMA-Mod (J factor at each contact point), 

- AGMA (“),

- Aida and Terauchi,

- Finite Strips (option).
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Function Buttons (User Defined Mode)

Geometry Group

Actions Group

Toggles Group

Output Group

Units Group
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Teeth and Machine
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Tooth – M/C -> Tooth Child Window

 

O.B. Blade 

Feed Mark 

I.B. Blade Current  

blade-to-workpiece 

contact point 

Finish + rough (fixed setting)

Blade animation (FH only)
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Tooth – M/C -> Tooth Child Window

STEP Output -> Export to CadCam
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Tooth – M/C -> Blank Child Window
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Tooth – M/C -> Dia. over Balls Child Window – Bevel gears

Give Ball dia. + distance -> Get Dia over Balls Give Ball dia. + Diameter -> Get distance
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Tooth – M/C -> Caliper Measurement Child Window – Cylindrical gears

Give # Teeth -> Get measurement
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Tooth – M/C -> Cutting Machine Child Window -> Conventional Generator
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Tooth – M/C -> Cutting Machine Child Window -> Phoenix Generator
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Kinematics and Contact Pattern
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Kinematics -> E/P Grids
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Kinematics -> Path of Contact Child Window

PoC

On the Gear tooth flank

Geometry name

Current tooth flank
CP limited by PoC

No Error Surface

PoC calculated by 

tooth Flank Normals

Tooth state

EPG values

Actual backlash
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Kinematics -> Path of Contact Child Window

 

Start of Contact 

End of Contact 

Pitch Point 

Preceding Tooth 

Following Tooth 

 

Start of Contact 

End of Contact 

Pitch Point 

Following Tooth 

Preceding Tooth 

PoC on Hypoid gear PoC on Spur gear
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Kinematics -> Path of Contact Child Window

PoC on Hypoid gear PoC on Spur gear
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Kinematics -> Contact Pattern Child Window

Contact Pattern

On the gear tooth flank

Geometry name

Current tooth flank

CP limited by PoC

No error surface

PoC calculated by 

tooth flank normals

Tooth state

EPG values

Actual backlash

Contact Ratio
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Kinematics -> Contact Pattern Child Window

Relationship between Error Surface and CP
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Kinematics -> Contact Pattern Child Window

Example: Use the Demo1441.dat geometry, for the Gear. 

Test the following Contact Pattern child window function buttons, one by one :

- ^N toggle in and out of the calculation of the PoC by the normals

- E/P change Horizontal to 25%, 75% - then Cancel – check the EP values 

- Limi toggle in and out of limited PoC

- NoRs toggle into rendered display

- Thick change CP compound thickness

- PoC toggle in and out the display of the PoC
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Kinematics -> Contact Pattern Child Window

Grid – display a grid with E and P = 0.200 mm (Apply button)
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Kinematics -> Contact Pattern Child Window

Grid – display a grid with E and P = 0.200 mm + rendering (Apply button)
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Kinematics -> Contact Pattern Child Window

With CMM Data 

- Delete the Contact Pattern child window

- Create a new Contact Pattern child window

- XYZ – make sure “Gear” is displayed in the Geometry field

- Use the […] button to browse

- Select the demog128.mes file

- Click on “Apply”
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Kinematics -> Contact Pattern Child Window

With CMM Data 

- Click to select “Pinion” in the Geometry field

- Use the […] button to browse

- Select the demo_p12.mes file

- Click on “Apply”

- Click on “Ok”
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Kinematics -> Contact Pattern Child Window

With CMM Data

- Click on the “NoEr” function button – watch the CP change 

- Click on the “Opt” function button – Select 2nd Order Regression - watch the CP change 

- Press “^S” to save the measurement datafile names in the geometry file
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HyGEARS can calculate how load is shared between adjacent tooth pairs, accounting for tooth 

bending and shearing stiffness, and contact deformation. 

Pitch errors can also be introduced in the analysis.

Results include 

• Contact stress (by Hertz) (Roark, Formulas for Stress and Strain, 1975), 

• Maximum Shear stress, 

• Depth of maximum shear, 

• Minimum Oil film thickness (Hamrock, 1994), 

• Flash temperature (ΔT over mesh; Blok’ s Flash Temperature, Erichello, 1991).

Kinematics -> Contact Pattern LTCA Child Window
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Kinematics -> Contact Pattern LTCA Child Window

Contact Pattern LTCA

On the gear tooth flank

Geometry name

Pinion torque

No error surface

PoC calculated by 

tooth flank normals

EPG values

Actual backlash

Stiffness/contact 

formulations
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Kinematics -> Contact Pattern LTCA Child Window

Evolution of the CP with applied torque
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i is the main tooth pair;

j is a tooth pair on either side of the main tooth 

pair (up to two on each side);

F i/j is the load applied on each meshing tooth 

pair;

K i/j is the tooth stiffness obtained from the 

Westinghouse beam formula or the FSM;

δH i/j is the Hertz contact deformation;

δW i/j is the displacement of a contact point caused 

by web shearing;

δR i/j is the displacement of a contact point caused 

by tooth base rotation;

δI i/j is the initial tooth separation;

R i/j is the radius of the point of contact;

T i/j is the torque share of each meshing tooth 

pair.

LTCA Solution:

Kinematics -> Contact Pattern LTCA Child Window
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• Surface principle curvatures are calculated (numerically) at each contact point.

• Relative directions of the principle curvatures affect contact stress and deformation.

Principle curvatures Feed Marks

Kinematics -> Contact Pattern LTCA Child Window
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δ w: displacement at point of applied load P

Hc: tooth height, between the applied load P 

and tooth root

Eb: tooth thickness at base

P: applied load (perpendicular to Hc)

F: tooth face width (projected in the 

direction perpendicular to P)

E: Young’s modulus

ν: Poisson’s ratio

𝑡𝑙:
𝐸𝑏

𝐻𝑐

Bending Displacement : Westinghouse beam formula
(Ted Krenzer, The Gleason Works, “Tooth Contact Analysis of Spiral Bevel and Hypoid Gears Under Load”)

𝛿𝑤 =
𝑃

3 𝐸
𝐹 𝑡𝑙

3

12

1 + 1.3 𝑡𝑙 + 0.25 + 0.75 1 − 𝜈 𝑡𝑙
2 + 0.35 𝑡𝑙

3

Kinematics -> Contact Pattern LTCA Child Window

© Involute Simulation Softwares Inc. 2021



LTCA – Lewis beam formula:

▪ J Factor extracted from the actual tooth section at the considered point along the PoC

( ) tF

W

Ft

hW LNLN 


sin

6

cos
2

−=


















−=

PtPXF

PW L

c

Lt 






tan5.1

cos

cos


















−=

PtPXY

L

c

L 



 tan5.1

cos

cos1

45.015.0

f
f

h

t

r

t
18.0K 


















+=

fK

Y
J =

JF

PWt=

cNt WW cos=

Xh
t

=







2

2

Kinematics -> Contact Pattern LTCA Child Window
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: Oil film thickness ratio

Hmin: Minimum oil film thickness

𝜎 m: Composite surface roughness

U: Dimensionless speed parameter

G: Dimensionless materials parameter

W: Dimensionless load parameter 

k: Ellipticity parameter

µ : Coefficient of friction (in oil)

X r: Load sharing factor (= 1 in HyGEARS)

W nr: Normal unit load

V rp: Rolling velocity of the pinion

V rg: Rolling velocity of the gear

b m: Thermal contact coefficient

b H: Semi-width of the Hertzian contact

Minimum oil film thickness:

For elliptical contacts:

For rectangular contacts:

Blok’s flash temperature:

 =
𝐻𝑚𝑖𝑛

𝜎𝑚

𝐻𝑚𝑖𝑛 = 3.63 𝑈0.68 𝐺0.49 𝑊−0.073 1 − 𝑒−0.68𝑘

𝐻𝑚𝑖𝑛 = 1.714 𝑈0.694 𝐺0.508 𝑊−0.128

𝛥𝑇𝑓 =
0.8 µ 𝑋𝑟𝑊𝑛𝑟 𝑉𝑟𝑝 − 𝑉𝑟𝑔

𝑏𝑚 𝑏𝐻

Kinematics -> Contact Pattern LTCA Child Window
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Kinematics -> Contact Pattern LTCA Child Window

Use the 11x45a.dat geometry, for the Gear. Test the following Contact Pattern LTCA child 

window function buttons, one by one :

- Opt –> Results - select “Depth – Max Shear”

- 2D – get into 3D mode

- ^J – change to user defined projection mode (3 rotation arrows enabled)

- Get a proper view angle with the rotation buttons
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HyGEARS offers a Contact Element which is integrated to the LTCA.

The Contact Element:

• Subdivides the contact area into small rectangular areas, or contact cells;

• On each contact cell, the pressure is varied until the sum of the initial separation and 

deformation is equal on all contacting cells (Love, 1929)

• Provides results identical to Hertz for full contact ellipses; (results are different when ellipse 

is truncated);

• Contact Grid can be modified for increased precision / decreased computing times;

• Can account for surface deviations as obtained from the CMM

Kinematics -> Contact Pattern LTCA Child Window / Contact Element
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Contact deformation (Love, 1929).
𝜋 𝐸

1 − 𝜈2
𝑢𝑧
𝑝
= 𝑥 + 𝑎 𝑙𝑛

𝑦 + 𝑏 + 𝑦 + 𝑏 2 + 𝑥 + 𝑎 2

𝑦 − 𝑏 + 𝑦 − 𝑏 2 + 𝑥 + 𝑎 2
+

𝑦 + 𝑏 𝑙𝑛
𝑥 + 𝑎 + 𝑦 + 𝑏 2 + 𝑥 + 𝑎 2

𝑥 − 𝑎 + 𝑦 + 𝑏 2 + 𝑥 − 𝑎 2
+

𝑥 − 𝑎 𝑙𝑛
𝑦 − 𝑏 + 𝑦 − 𝑏 2 + 𝑥 − 𝑎 2

𝑦 + 𝑏 + 𝑦 + 𝑏 2 + 𝑥 − 𝑎 2
+

𝑦 − 𝑏 𝑙𝑛
𝑥 − 𝑎 + 𝑦 − 𝑏 2 + 𝑥 − 𝑎 2

𝑥 + 𝑎 + 𝑦 − 𝑏 2 + 𝑥 + 𝑎 2

E: Young’s modulus

ν: Poisson’s ratio

uz: surface deformation on a given cell

p: surface pressure on a given cell

x, y: coordinates of a point in relation to 

the center of a given cell

2a, 2b: sides of a given cell

X

2a

2b

Cell where pressure 

is applied
Cell where deformation 

is desired

Y

Path of Contact

Contact Line

Contact Grid

Kinematics -> Contact Pattern LTCA Child Window / Contact Element
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Contact Separation Contact Pressure

Contact Deformation Contact Force

Kinematics -> Contact Pattern LTCA Child Window / Contact Element
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Values are hidden Values are displayed

Kinematics -> Contact Pattern LTCA Child Window / Contact Element
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Ridging + Pits present on pinion tooth after initial run in:

• Gleason Summary was entered in HyGEARS

• LTCA run at expected operating position

Pinion tooth shows ridging + pits HyGEARS simulation (Hertz)

Kinematics -> Contact Pattern LTCA Child Window / Contact Element
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Pinion + Gear teeth measured

• Pinion + gear teeth R.E.

• LTCA run with Error Surface

• Use of Error Surface with Contact Elements analysis

#1 #2 #3

#4 #5 #6
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Pinion + Gear teeth measured

• Pinion + gear teeth R.E.

• LTCA run with Error Surface

• Use of Error Surface with Contact Elements analysis

#7 #8 #9

#10 #11 #12
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Pinion redesigned:

• Moved the CP away from fillet at heel

• Kept same blank, cutter, etc.

• Lower Hertz stresses at contact entry

Original Redesigned
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Comparative Contact Element Analysis:

Original #5 #6

Redesigned #5 #6
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Comparative Contact Element Analysis:

Original #7 #8 #9

Redesigned #7 #8 #9
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Kinematics -> Contact Pattern LTCA Child Window

- “NoCE” – toggle into Contact Element display

- “^Z” – zoom onto the desired tooth area

- “Opt” – select “Contact Pressure”
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Kinematics -> Contact Pattern LTCA Child Window

- “NoDi” – toggle in dimension display

- “Opt” – select “Contact Deformation”

- +/- - scan through the PoC
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Kinematics -> Contact Pattern LTCA Child Window

- Close the Contact Pattern LTCA child window

- Create a new Contact Pattern LTCA child window

- Click on “Grid” – select Torque and leave inputted value – click “Ok”
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Motor controller

Data acquisition
system

Encoder solver

Computer

Encoder sets

Slip rings

30:1 speed reducer

Disk brake

couplings

Load cell

Electric motor

Pinion

encoder set

Gear

Pinion

Gear

encoder set

Couplings

Optical

encoder

Analog

encoder

Shaft from

pinion/gear

Section A-A

(through encoder set)

Test gearset setup

Top view

A

A

P

G
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Reverse Engineering

Pinion Gear
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LTCA - Compressive Stress - MPa - Gear:
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LTCA - Compressive Stress - MPa - Gear Convex:
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LTCA - Compressive Stress - MPa - Gear:
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Kinematics -> Contact Pattern Development Child Window
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Kinematics -> Contact Pattern Development Child Window
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Kinematics -> Contact Pattern Development Child Window

Use the 11x45a.HyG geometry, for the Gear. Test the following Contact Pattern Development 

(Pinion) child window function buttons, one by one :

- “CPat” – call the Contact Pattern Development selection window

- Input the values as displayed below
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Kinematics -> Contact Pattern Development Child Window

- Scan through the various Tabs to see the displays

- Input the values as displayed below
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Kinematics -> Contact Pattern Development Child Window

- Click on the “E/P” tab

- Select 25% for the Horizontal and click on “Apply”; watch the EP values

- Click on “Cancel”
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Kinematics -> Contact Pattern Development Child Window

Use the 11x45a.dat geometry, for the Gear. Test the following Contact Pattern Development 

(Pinion) child window function buttons, one by one :

- Click on the “Prop” tab

- Input the values as displayed below – click on “Apply”
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Kinematics -> Sliding Speeds Child Window

Hypoid gear Straight Bevel gear
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Kinematics -> Ease Off Child Window

Ease Off

Pinion tooth flank shown

Geometry name

Current tooth flank

No error surface

PoC calculated by 

tooth flank normals

EPG values

Backlash
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Kinematics -> Ease Off Child Window

Ease off Surface statistics
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HyGEARS offers several tools for Production control. For Spiral-Bevel and Hypoid gears, CMM 

functions have been developed to:

– define where measurement on the tooth flank is to be performed;

– convert and display surface measurement (from any CMM) for quality control check;

– calculate Corrective Machine Settings; deviations can be added to pre-compensate for heat treat. 

deformations;

– Reverse-Engineer measured surfaces using the proprietary Surface Match algorithm.
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Measurement, Corrective Machine Settings and Reverse Engineering
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Measurement -> CMM Data selection and conversion

Test if the data file is of :

• “Ram” type;

• “Rfd” type;

• “Gleason-Zeiss” type;

• “Hoeffler” type;

• “MdM” type;

• “Klingelnberg-P” type;

• “GAGE” type;

• “Zeiss Gear Pro” type;

• “HyGEARS” type.
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The Surface Match algorithm (1994) :

– Changes the machine settings of the selected member until the measurement surface 

statistics are within given tolerances;

– Uses the sensitivity of the error surface (difference between measurement and simulation) 

to chosen control parameters to iterate until the desired tolerances are met;

– Applies a Newton-Raphson based iterative process to solve the objective functions.

Measurement -> Surface Match Algorithm for Correction / R.E.
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Pressure Angle Error:

Spiral Angle Error:

Crowning Error:

Measurement -> Surface Match Algorithm for Correction / R.E.
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Warp Error:

Taper Error:

Measurement -> Surface Match Algorithm for Correction / R.E.
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Where:

i is the index of row measurement data, along the tooth 

flank;

j is the index of column measurement data, across the 

tooth flank;

mid is the index of the mid-column or mid-row 

measurement data;

ei,j is the error value at point ij of the measurement grid;

xi,j is the distance between measurement points along the 

tooth flank;

yi,j is the distance between measurement points across 

the tooth flank.

Surface Statistics:

Measurement -> Surface Match Algorithm for Correction / R.E.
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 is the average pressure angle error;

 is the average spiral angle error;

 is the averaged crowning error;

 is the averaged warp (bias) error;

Ti are the requested deviations;

Li are the tolerance limits;

Objective Functions:

1st Order:

2nd Order

Measurement -> Surface Match Algorithm for Correction / R.E.
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Jacobian (or 1st order sensitivity) matrix:

1st Order:

2nd Order:

 is the average pressure angle error;

 is the average spiral angle error;

 is the averaged crowning error;

 is the averaged warp (bias) error;

Measurement -> Surface Match Algorithm for Correction / R.E.
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Algorithm flow chart:

Measurement -> Surface Match Algorithm for Correction / R.E.
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Measurement -> Corrective Machine Settings and R.E. selection window

Tolerance options on target values and tolerances; 

Order options on what is to be corrected;

Machine options on control parameters constraints;

Correction calculated changes in machine settings;

Expected Stats what HyGEARS hopes to achieve after correction;

Errors point by point differences
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Measurement -> Corrective Machine Settings and R.E. selection window

Tolerance options on target values and tolerances; 

Order options on what is to be corrected;

Machine options on control parameters constraints;

Correction calculated changes in machine settings;

Expected Stats what HyGEARS hopes to achieve after correction;

Errors point by point differences
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Measurement -> Corrective Machine Settings and R.E. selection window

Tolerance options on target values and tolerances; 

Order options on what is to be corrected;

Machine options on control parameters constraints;

Correction calculated changes in machine settings;

Expected Stats what HyGEARS hopes to achieve after correction;

Errors point by point differences
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HyGEARS offers Corrective Machine Settings (similar to Gleason’s GAGE)

CMM data is used to calculate changes in machine settings needed for the actual tooth surface to 

match the theoretical tooth surface.

Corrective Machine Settings support:

• 1st order errors: spiral angle, pressure angle, tooth taper;

• 2nd order errors: crowning and tooth warp (bias);

• Roughing and Finishing;

• All FM and FH cutting processes

Measurement -> Corrective Machine Settings
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Measurement -> Corrective Machine Settings
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Measurement -> Corrective Machine Settings
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Measurement -> Corrective Machine Settings
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HyGEARS uses the Surface Match algorithm to Reverse Engineer existing tooth surfaces.

Reverse Engineering is useful to:

– identify the machine settings of existing gear sets for which the summaries are lost;

– analyze existing gear sets and identify the machine settings or provide a reference surface 

leading to quietness;

– diagnose the reason for a failure by simulating meshing and load sharing;

– optimize the Stock Distribution;

– use different cutters on a given geometry (Fixed Setting only);

– calibrate mechanical machines to pre-compensate for their inaccuracies;

– etc.

     

Measurement -> Reverse Engineering
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Measurement -> Measured Surfaces Child Window

  

Measured 

Teeth 

  

Measurement 

Grids 

Measured Surface Pinion/Gear

Geometry name

Measurement datafile 

name

Finish/Rough
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Measurement -> Measured Surfaces Child Window

Use the Demo1441.HyG geometry. Test the following Measured Surfaces child window 

function buttons, one by one :

- Create a Measured Surfaces Child window for the Gear

-“3D” – toggle in and out of 3D mode

- “XYZ” to select which tooth to display (use #1)

- “NoPo” – toggle in the display of the Contact Pattern

- “ErrS” – toggle the CP into using the Error Surface – use “Linear” in “Opt”

- “Scal” – change the scale such as to view the Error Surface deviations
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Measurement -> Compare Meas-Sim Surfaces Child Window

Rough/Finish

Pinion/Gear

Geometry name

Thickness error

Measurement datafile
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Measurement -> Compare Meas-Sim Surfaces Child Window

1st order errors 2nd order errors
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Measurement -> Compare Meas-Sim Surfaces Child Window

Use the Demo1441.HyG geometry. Test the following Comp Meas-Sim Surfaces Child 

window function buttons, one by one :

- Create a Comp Meas-Sim Surfaces child window for the Pinion

- “Stat” – call the Surface Statistics Output – compare with the Error Surface
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Measurement -> Compare Meas-Sim Surfaces Child Window

- “Scal” – experiment changing the scale from Auto to any available value

Auto-Scale

Scale = 10 um
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Measurement -> Compare Meas-Sim Surfaces Child Window

- “Outp” – call the Error Surface Output
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Measurement -> Stock Distribution Child Window

Rough/Finish

Pinion/Gear

Stock Distribution
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Measurement -> Corrective Machine Settings Child Window

Rough/FinishPinion/Gear

Corrective Machine Settings

Geometry name

Thickness error

Measurement datafile

Corrective M/C Settings: machine changes for the manufactured tooth to match the design tooth
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Measurement -> Corrective Machine Settings Child Window

Use the Demo1441.HyG geometry. Test the following Corrective Machine Settings child 

window function buttons, one by one :

- Create a Corrective Machine Settings child window for the Pinion

- “Sett” – call the Corrective Machine Settings selection 

- “Order” Tab – select 2nd Order
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Measurement -> Corrective Machine Settings Child Window
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Measurement -> Corrective Machine Settings Child Window

- Check the displays in all other Tabs

- Click on “Ok” to keep, “Cancel” to dump
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Measurement -> Reverse Engineering Child Window

Rough/FinishPinion/Gear

Reverse Engineering

Geometry name

Thickness error

Measurement datafile

Reverse Engineering: machine changes for the design tooth to match the manufactured tooth
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Actual gears + CPs

Simulated CPs after R.E. based on CMM data 

(noisy- whining)

CPs after re-development based on R.E. Gear

Measurement -> Reverse Engineering
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Measurement -> Reverse Engineering

© Involute Simulation Softwares Inc. 2021



Mild and 

shallow TE

Measurement -> Reverse Engineering

© Involute Simulation Softwares Inc. 2021



Deep and 

sharp TE

Measurement -> Reverse Engineering
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Measurement -> CMM Nominal Data Child Window

Rough/Finish

Pinion/Gear
CMM Nominal Data

Geometry name
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HyGEARS allows the definition of the Target CMM grid. 

– Output can be done for several popular CMMs

– Edge reductions can be inputted at tooth Bottom, Top, Toe 

and Heel;

– After measurement, the CMM output file is converted into 

a HyGEARS specific format for fast access;

– Probe ball can be displayed and moved at target points to 

visualize potential interference;

Measurement -> CMM Nominal Data Child Window
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Measurement -> CMM Nominal Data Child Window

- “2D” to change to 3D view;

- Rotate the display until a proper viewing angle is obtained;

- “Dims” to hide the CMM grid dimensions;

- “^Z” to toggle into Manual Zoom; zoom onto the Grid area;

- “Ram” function button – check the “Show Probe Ball” and enter 2.0 mm

as the Probe Diameter; click on the “Apply” button;

- “+/-” with the left and right mouse buttons to move the probe along the

tooth flank;

© Involute Simulation Softwares Inc. 2021



2D Graphs Child Window

Rough/Finish
Allways Pinion

Current Pinion tooth flank

Geometry name
PoC calculated by normals

EPG values
Pinion torque

Contact ratio Ltca

Contact/sitffness 

models
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2D Graphs Child Window

Display options

X-Axis options

# curves displayed Scale can be Auto or 

Manual
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2D Graphs Child Window

Display options

X-Axis options

# curves displayed When Scale is Manual, 

bounds must be provided
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2D Graphs Child Window

Display Options

- TCA: - FFT TCA:

- LTCA: - FFT LTCA:

- Torque: - Load:

- Transm. Force: - Sum Load:

- Bending Def.: - Contact Stress:

- Contact Def.: - Min. Oil Film:

- Lamda: - Efficiency:

- Efficiency Ltca: - Frict. Coef. Ltca:

- Temp Increase: - B. Stress Pinion:

- B. Stress Gear: - J Factor-Pinion:

- J Factor-Gear: - Kt - P:

- Kt - G: - #1… Gage Pinion

- #1… Gage Gear: - %:

- K-Flex: - K-Mesh:

- Tooth Separation - Sliding Speeds:
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2D Graphs Child Window

Text output of a 2D graph
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2D Graphs Child Window

TCA curve FFT TCA curve LTCA curve
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2D Graphs Child Window

- “2D Graph” - Create a 2D Graph child window; select “TCA”, click on “Ok”;

- “Grid” function button – enter E and P as 0.200 mm; click on “Ok”
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Need to see how some LTCA metrics evolve with torque;

• Display TE under load f(Torque)

• Display Sc f(Torque)

• Display SCP, SbG f(Torque)

No TopRem TopRem “Bk”

LTCA TE-P2V Child Window
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HyGEARS offers an advanced meshing interface in which a FEA mesh can be defined and outputted in 

a matter of seconds. 

• An FEA mesh is based on the same tooth surface as that obtained by the machine settings.

• Loads can be applied, in different manners, anywhere on the tooth surface.

• Export in Patran Neutral file format

Meshing -> FEA Model Child Window
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HyGEARS offers a proprietary solution to bending stiffness and stresses: the Finite Strips. 

In short, the Finite Strips are a subset of the Finite Elements. 

Using thick plate theory combined to smooth series, accurate tooth stiffness and bending stresses can 

be obtained in a matter of seconds.

Meshing -> Finite Strips Child Window
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Strips of width b and length (or height) a are parallel to the λ-axis and connected by nodal lines; the 

nodes are used to define the displacement function.

Meshing -> Finite Strips Child Window

© Involute Simulation Softwares Inc. 2021



The displacement function  of a strip is expressed as the sum of a series of l terms:

where       is a combination of polynomial Ni and series       ,        and      :

Using Mindlin’s plate theory, the mid-plane displacement vector of a strip is:

The vector of nodal parameters of node i for the mth function is:

The Finite Strip stiffness matrix for functions m, n and nodal lines i, j is written as:
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Meshing -> Finite Strips Child Window
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Meshing -> Finite Strips Child Window
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The figures below show the bending stresses in a Helical gear tooth, in two different contact positions 
using the results of the Loaded Tooth Contact Analysis for applied load and extent of the Contact 
Pattern.

Typical pre-processing and solution times < 0.3 sec. on standard 2.4 GHz computer. The Finite Strips 
are therefore an excellent tool to design and optimize a geometry .

Meshing -> Finite Strips Child Window
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(a) Spur (b) Straight-Bevel

(c) Face (d) Spiral-Bevel

FEM models

Meshing -> Finite Strips Child Window
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Rear pinion bearing

X : 200N Y : 250N Z: 80N

2nd harmonic higher than 1st harmonic, high response at 730 Hz
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Forces reduced to 30% of green cut due to optimization in TE.

Rear pinion bearing

X : 80N Y : 100N Z: 25N
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Worst Case Scenario

–Contact Pattern / Contact Stresses

–Transmission Error

Stiff bearings and supports Support stiffness = 50 k-lbs/in Support stiffness = 50 k-lbs/in
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Gleason Summary provided by customer Data entered in HyGEARS
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Visually verify Pinion and Gear teeth for:

– Insufficient Topland

– Undercutting
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Design, is analyzed for:

– Position/Alignment sensitivity

P

E

Radial

Radial

G

Shaft Angle

Alignment

Gear Run out

Pinion Run out

© Involute Simulation Softwares Inc. 2021



© Involute Simulation Softwares Inc. 2021



© Involute Simulation Softwares Inc. 2021



© Involute Simulation Softwares Inc. 2021



© Involute Simulation Softwares Inc. 2021



Design, is analyzed for:

– Worst case scenario

P-0.011E 

0.0185

Radl 0.000

Radl 0.000

G 0.044

Sig 0.00°

Align 0.00°
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Worst Case Scenario

– Contact Pattern / Contact Stresses

– Transmission Error
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Worst Case Scenario: Check for Fillet Interference
E=0.0185 P=-0.011 G=0.044 Sigma= 0.00 Align=0.00°
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Worst Case Scenario: Pinion fillet stresses
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Worst Case Scenario: Gear fillet stresses
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Abrasive rate of wear is proportional to:

▪ L Sliding distance

▪ W Load

▪ H Hardness

Calculated CP before lapping After lapping
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Experimental wear coefficients 11x41:
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Experimental wear coefficients 12x41:
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Prediction and measured …
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1. HyGEARS’ tooth flank generation and TCA calculations match Gleason’s CAGE and 

Klingelnberg’s KIMoS; therefore, the reference topography in HyGEARS is the exact tooth 

definition;

2. HyGEARS designs gear set geometries, i.e. the machine settings for all HyGEARS supported 

geometries are calculated and a Summary is created;

3. Geometries can be imported from Gleason SPA and KIMoS ND files; 

4. Spiral bevel cutting processes such as Face Milling and Face Hobbing are integral to HyGEARS;

5. Geometries can be analyzed unloaded and loaded for contact and tooth fillet stresses;

6. 5Axis CnC machine Post-Processing, i.e. the generation of a part program “machine ready”, is 

integral to HyGEARS;

7. Part programs are generated in reference to the exact tooth surface definition (rather than an 

interpolated surface as is the case with the many other softwares);

8. Part program generation is based on user selected cycle features;

9. Any 5Axis CnC machine architecture can be accommodated; current architectures include “AB”, 

“AC”, “BA” and “BC”; any controller can be accommodated; current controllers include 

GCodes, Siemens, Heidenhain and Fanuc;

10. Part programs can be in Machine coordinates, Work piece coordinates with axis angles, or Work 

piece coordinates with tool axis vector (Traori, TCPM and TCP);
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11. Users can define their own tool box for Face Mill, CoSIMT, End Mill and Ball Mill tools;

12. Cutting Cycles include Slot by Slot and Flank by Flank, both for tooth flank and fillet; tip 

chamfering is available;

13. Animations and single stepping allow the visualization of tool movements and the verification of 

tool paths and possible interference;

14. A “Metrics” function gives an estimate of the deviations between the theoretical tooth flank and 

the “flats” and “peaks” created by the discrete movements of the tool;

15. Toe and Heel clearances allow smooth tool entry and exit;

16. “Stock” allowance is available for roughing and finishing;

17. A “Roughing mode” moves the selected tool in the center of the gap to quickly remove as much 

material as possible;

18. “Operations”, including all user selections for a given task, may be saved for later re-use;

19. Closed Loop, also called Corrective Machine Settings, is integral to HyGEARS and allows the 

seamless manufacture of gears to the required tolerances.
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